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Report Manager Training — Part 1

This guide is Part 1 of a three-part series teaching how to effectively use Report Manager. In this
Part 1 of the series, you will:

Become familiar with the Report Manager user interface

Know how to organize reports

Understand viewability of reports and report data

Practice simple report manipulation

AN NI NN

HINT- These are hints and best practices for students.

Introduction to Report Manager

Explore the User Interface

Let’s look at the Report Manager interface to become familiar with the components. This section
provides a brief understanding of the interface which is discussed in more detail throughout this
series of Report Manager Guides.

1. Log in CPDOnline using your Credit Union Administrator password.

2. Click the Report Manager mode icon & at the top of your screen.
3. The Report Manager tutorial automatically opens. For now, close it.

CPDOnline VI Leve
File Tools Add-Ins |E I'E TE Wﬁ—'
Report Type: |A
| Learner [v]
Filter By: |
| |
= Development Flans
Report: Untitled (O x|

Run Existing Report

The Report Manager screen has three areas. At the far left is the Catalog area. At the far right is
the Report Area where the reports can be views as text and numbers and/or graphically. Across
the top is the beige Menu bar.

1. Under Report Type, choose Administrator.

2. Click the plus sign next to the Registrations folder then choose Yet to be Completed
Exam Enrollments report.
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Report Manager Training — Part 1

HINT You may see this message. This simply means that the browser must be set up to
accept data to pass freely from the server to the local machine. This message will appear the
very first time a machine is used to access Report Manager. If this message appears, follow
the simple steps outlined in the error message.

CPDOnline AEOUPECATUS

File Tools Add-Ins U of [% @ |
Catalog DI

Data Access Pages has detected that your IE security settings will not allow you to access data from a i:

Report Type: zite considered to be insecure.
| Administrator |V] E s
In order to access the data contained within the Data Access Page, you need to:
Filter By:
I all |:I 1. Start IE

(=) 2. Chooze Internet Options from the Tools menu
Development Flans

® 2 Evaluations [11
2D Registrations [2]
iﬂ Sample Registrations for
Training Coordinator

-} Yet to be Completed
Exam Enrollments 5. Click on the "Sites..." button

D Skills and Competencies

3. Click on the "Security" Tab

4, Click on the "Trusted Sites" icon

6. Uncheck the "Require server verification (https) for all sites in the zone" checkbox

7. Add "https://totalrm2stage.sumtotalsvstems.com/ cunaaffiliatesstage BIF/
(3wllciuciZeuasig01ksgh55)/BIPDefault.aspx?
Zz=1816558t=200610231344158a=MYEhtUC4c8cMToRGHIG81%:2B74bs8%
3D&m=31a&l=/cunaaffiliates/lang-en/ &st=ug81SifiNgPZNOmsG4wvEBoPYvWE % 3DAs=18ViewlD=02" as
a trusted server

3. OK the dialog

9. Try to open the Data Access Page

3. The report appears.

Page 4 of 10



Report Manager Training — Part 1

D E O |

-'3 Development Flans
® 2 Evaluations [1]

Registrations [2]

u Sample Registrations for
_ Training Coordinator

L} Yetto be Completed

Exam Enrollments

i Skills and Competencies

CPDOnline @YY e e
File Tools Add-Ins IENE G E T
Report Type: T = — 1
- : Cumpletmn Status ¥ |
| Administrator |_Z] NC_IT. Cqmpleteg
Filter By: |- ! HEd
[ [+ User Name Ct""t‘i" Code i r&d.'.‘ity_Na_me_ ) T
= Doe. Jane R101CEC  Tmthin Savings - NCUA Part 707 8/15/2006

| | R101CEC

R101CEC
Eight, Learner
Eight, Manager ¥ R101CEC
R10MCEC
R101CEC

Smith. Sandy % A1002X

_Truth in Savings - NCUA Part 707
Truth in Savings - NCUA Part 707

Truth in Savings - NCUA Part 707 8/23/2006
CUS Sales FINAL EXAM

Truth in Savings - NCUA Part 707 B-’14f20[]5

Maoney

d MNegotiable Instrumen

Truth in Savings - NCUA Part 707 8.f23x2005

8/15/2008

Smith, Suzie

Student. Joe

| RIMCEC

Truth in Sa\nngs

Truth in Savings -
Truth in Savings -
_Truth in Savings -
Truth in Savings -
Truth in Savings -
Truth in Savings -
Truth in Savings -
Truth in Savings -
Truth in Savings -
Truth in Savinns -

TNCUA Part 707
MCUA Part 707
MCUA Part 707
NCUA Part 707
NCUA Part 707
NCUA Part 707
MNCUA Part 707
MCUA Part 707
MCUA Part 707
MCUA Part 707
LJCLIA Part 707

8/16/2006
8/29/20086
3/29/2006
8/15/2006

8/15/2006

8/15/2006
8/15/2006
8/15/2006
8/16/2006
8/16/2006
21452006

Catalog Area

The Catalog area displays the Report Type, Filter By, and Folders. Report types categories items.
Report type drives the set of folders and therefore the reports available. Although any report may
be placed under any report type, reports should be placed in the report type that makes most
sense.

The Filter By drop down list box controls what the reports are viewed below — all, public only,
private only, or by name (which allows for a search for words contained in the report name).

The folders further categorize the reports.

Report Area

Half of the Report Area (by default the top half) will display the text and numbers related to the
report. The other half of the Report Area (by default the lower half) can display the report
graphically such as by bar chart or pie chart. The report may be manipulated in either area; a
change in one area is reflected automatically in the other.

Top Menu Bar

The top menu bar is used to perform tasks such as saving the report, importing reports, or set
preferences. We'll go into more detail later.

Also on the top menu bar are icons that control how Report Manager is displayed.
I:;-1‘_'lShows or hides the Catalog area of Report Manager.

e Shows or hides an Add-In area of Report Manager.

E% Shows or hides the text and numbers area of the report.

M shows or hides the graphical area of the report.
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Report Manager Training — Part 1

Report Area Toolbar

Let's explore the buttons at the top of the report area. First, start by running an existing report.

1. Under Report Type, choose Administrator.

2. Click the plus sign next to the Registrations folder then choose Yet to be Completed
Exam Enrollments report.

3. The report appears.

CPDOnline Ve LWeWwe
File Tools Add-Ins e o (8 @ |
oo B
Report Type: M | % @' = 2L :“‘l’! -J'L:'T' | = ﬁ; @ 0 | e | ! | x{? | % S| | @ )
Completion Status ~
| Administrater |i-| Naot Completed
Filter By: Dirop umn Fi lere
(2 = User Name ¥ | Activity Code v |Activity Name v |Atternpt Start Date »
Doe, Jane | RI101CEC Truth in Savings - NCUA Part 707 8/15/2006
o T -~ I'| r101CEC Truth in Savings - NCUA Part 707 8/14/2006
BED Brifistine i1l : R101CEC Truth in Savings -.NCUA Part 707 8.{15.-“2[][]6 3
28D Registrations [2] Eight, Leamer | Money and Megoatiable Instruments 9/13/2006 3
i) sample Registrations for  ||Eight. Manager 2| R101CEC Truth in Savings - NCUA Part 707  8/23/2006
Training Coordinator R101CEC Truth in Savings - NCUA Part 707  8/23/2006
(L} Yet to be Completed _RIDICEC Truth in Savings - NCUA Part 707 8/23/2006
e Eg“‘"’““'“'s . ||Smith, Sandy # A1002X CU Sales FINAL EXAM 8/15/2006
Skills and Competenaes | |g ih Suzie *| R101CEC Truth in Savings - NCUA Part 707 8/15/2006
| R101CEC Truth in Savings - NCUA Part 707 8/29/2006
R101CEC Truth in Savings - NCUA Part 707 8/29/2006 k|
R101CEC Truth in Savings - NCUA Part 707 8/15/2006
Student, Joe X[ R101CEC Truth in Savings - NCUA Part 707 8/15/2006
| R101CEC Truth in Savings - NCUA Part 707 8/15/2006
R101CEC Truth in Savings - NCUA Part 707 8/15/2006
R101CEC Truth in Savings - NCUA Part 707 8/15/2006
R101CEC Truth in Savings - NCUA Part 707 8/15/2006
R101CEC Truth in Savings - NCUA Part 707 8/15/2006 d
B10ICEC Truth in Savings - NCLIA Pat 707 8152006 |v

HINT What is in focus (clicked on) or selected in the report area makes buttons on the toolbar
enabled or disabled.
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Below is each icon with a description of their function. As this series of Report Manager courses
progresses, you will learn more about these controls.

B8 About — displays information about Microsoft Office Web Component (OWC) including version
installed.
&) Print — prints the report.
Print Preview — allows a preview of the report before printing (using Microsoft Excel).
Copy — allows you to copy a set of reports.
21 sort Ascending — sorts records in an ascending (A to Z) order.
a4 sort Descending — sorts records in a descending (Z to A) order.

AutoFilter — toggles between showing all data and showing only filtered data.

" Show Top/Bottom Items — Shows a specified percentage or number on top or on bottom of

the list.

== AutoCalc — allows creation of total fields such as the sum, count, minimum, maximum, etc.
Subtotal — Hides or shows the subtotals or grand totals for a column or row.

Calculated Totals — allows you to specify a computation to display on the report.

%: Show As — Shows values as a percentage rather than a number.

= Collapse — Hides lower level items for a column or row.

“= Expand — Shows lower level items for a column or row.

= Show/Hide Details — Hides or displays details for a column or row.

! Refresh — refreshes the report. May take several minutes depending on the report and the
report cannot be interacted with while refreshing.

2 Export to Excel — exports data to an Excel spreadsheet.

Commands and Options — opens or closes the Commands and Options window.

Bl pivotTable Field List — opens or closes the Pivot Field List.
@ Pivot Table Help — opens or closes the help specific to creating and modifying pivot
tables.
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Arranging Reports

Let's explore the different ways you can organize reports including creating a report type and a
new folder. We'll also discuss public v. private reports and what data you or others may see in
reports.

Report Types

Four report types are created by default — Learner, Instructor, Manager, and Administrator. You
are able to create you own private Report Type.

1. Under the File menu, choose New, then choose Report Type.

2. Type a unique report type name (add initials and an underscore to the front of the report
type name) and click Add.

3. Click Close.

4. Notice a new report type displays in the Report Type drop down list box. This is a private
report type which means only you can see it.

Create your own Folder

You may also create your own private folder.
1. Choose the Report Type in which the new folder should be created.
2. Under the File menu, choose New, then choose Folder.
3. Type a unique folder name (add initials and an underscore to the front of the folder
name) and click Add.
4. Click Close.

Private v. Public Reports

Above, we have mentioned that report types or folders may be private. You have permissions to
create new report types, folders, and reports as well as the ability share them with other users.
You determine who can view these items by defining the users who will be the audience. How to
do this is covered in Part 2 of the Report Manager Series.

Viewable Report Data

Credit Union Administrators (CU Admins) can view everyone in their Credit Union. This means
that if a CU Admin runs a report to see who has completed a certain learning activity, the only
people who appear in the report are people in their credit union. The CU Admin cannot see
people from another credit union even though they have also completed that same learning
activity.

Additionally, CU Admins can see only learning activities of the type:

v' CU Express Activity

v" CUNA Course

v" CUNA Exam
If a CU Admin runs a report on all learning activities, only the learning activities of the above
types will appear, no others. For example, if a CU Admin runs a report to see user who have
completed learning activities in the last month, the report will only display learning activities of
the three types listed above even though learners they are allowed to see have completed other
kinds of learning activities. If reports are run for learning activities of another type, no data
appears. You are able to show your result data to others which is discussed in Report Manager
Training Part 3.
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Simple Report Manipulation

Let's make some modifications to an existing report by moving some report objects around then
adding a field and using it as a filter.

Move Report Objects

If it is not open already, open the report “Yet to be Completed Course Enroliments.”

1.
2.

3.
4.
5

Under Report Type, choose Administrator.

Click the plus sign next to the Registrations folder then choose Yet to be Completed
Exam Enrollments report.

The report appears.

Try moving objects around on the screen.

Try removing the Registration Status field off the report.

Add Filters and/or Fields Using PivotTable Field List

Replace the Registration Status Field

Let's replace the Registration Status field as a filter.

1.

Click the PivotTable Field list icon & on the tool bar. This field list shows all the fields
available to use within this report. Fields not in this list are not available to use in this
report.

HINT The PivotTable Field list appears at first to be in alphabetical order, but it is not.
Be sure the Registration Status field is removed. To remove it, scroll to about the middle

of the PivotTable Field list, select Registration Status and drag and drop that onto the
filters area just below the toolbar.

Add a New Filter

Scenario: Let's say you now need to filter by manager. This means the Manager Name field must
become a filter for the report.

1.
2.

3.
4.
5

In the PivotTable Field list, find and select Manager Name.

Drag and drop Manager Name into the filter area just under the toolbar in the report
area.

Click the down arrow next to the Manager Name filter.

Click All. Notice that clicking all selects or deselects all options.

Select only a few managers and click OK. Notice the report results change from showing
all users to only those users who have the manager selected above.

HINT When a filter has specific items selected the text below the filter changes to
indicate what is selected. For example, text below the Manager Name filter changes from
All to (Multiple Items). Additionally, the arrow icon next to the filter name changes from
black to blue when a filter is applied.

Click the AutoFilter icon to see how it toggles from no filters to applying the selected
filters.

Add a New Row
Let's say we'd like to add a see the user’s primary job next to the user name.

1.

In the PivotTable Field list, find and select User Primary Job.
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2. Drag and drop User Primary Job to the left of the User Name. Be sure the blue highlight
has a top and bottom horizontal line that point towards the User Name before dropping.

Conclusion

Resources: Class Series, Tutorial, and Online Help

There are three main ways to get help in Report Manager. This series of three Report Manager
Guides is here to teach you the basics of using Report Manager. Whenever Report Manager is
opened, the Report Manager tutorial appears. The tutorial was written by award-winning writers
and is wonderfully clear and helpful; I highly recommend it, it's a fantastic tool. Online help (also
written by award-winning writers) provides an excellent reference for specific questions about
using Report Manager. The online help has a Contents tab based on subject, an Index tab to
search by keyword, or a Search tab to search for any relevant string.

After this Part 1 of the Report Manager Series, you can now:
v" Navigate the Report Manager user interface
v" Organize reports
v" Understand private v. public reports and viewability of report data
v" Perform simple report manipulations

In Part 2 of the Report Manager Series, you will:

Use report features such as grouping, sorting, calculating, adding totals
Save modifications of an existing report to a new report

Create a brand new report from scratch

Regulate server-side filtering

Control viewability by job, manager, or individual

Delete reports

<]

ANENENEN

If you have any further questions on this material, please contact us at 800-356-9655 ext. 4072
or via e-mail at CPDOnline@cuna.coop.
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